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Introduction

The ATLAS Search tool is used to search or download data 

related to project development. Locate and analyze a variety 

of data layers from multiple sources at once. 

After logging in, you will have the option to use several 

different map functions. 

Click on the hyperlinks in the list to the right to jump directly 

to one of these topics. These individual topics are also 

available as separate modules in the training library, 

indicated by the module number in parentheses. 

To gain access to ATLAS or for questions, contact 

ATLAS@ncdot.gov.

☼ Learning Outcomes

In this module, the user will gain an understanding 

of how to:

► Log into ATLAS

► Overview of the Search Tool 

► Zoom Into Area of Interest

► Select Layers 

► Add Labels/Images and Measure

►Download Layers or Print Map

Tip: The Search Tool will time out after a period of 

inactivity. That may result in the map freezing, or 

some of the buttons becoming inactive. If this 

occurs, restart the Search Tool.

mailto:ATLAS@ncdot.gov
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0.0 Search Tool Uses

0.1 The ATLAS Search Tool has 3 primary 

high-level functions:

1. Find GIS data from multiple sources 

in one place

2. View data on map

3. Download multiple data sources at 

once in GDB, SHP, and/or DGN 

format

The ATLAS Search tool is useful when 

preparing for scoping, completing a 

technical report, or compiling an 

environmental document. For any data 

needs, the Search tool eliminates the 

need to look through various webpages 

and source agencies.

Find data 
from multiple 

sources

View data and 
print map

Download 
data for 

offline use

ATLAS Search Tool
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0.0 Search Tool Uses (continued)

0.2 The Search Tool provides a variety of different functions that can be used 

together or individually. There are four primary actions that can be done in any 

order. Click on the hyperlinks below to jump to slides within this training 

module for each, or advance to the next slide to review them all. 

Zoom Into Area of Interest: Find an area by downloading or creating a study 

area, or simply zooming into the map.

► Find Location ► Add Study Area

Select Layers: Select the layers to be viewed or downloaded.

► Search for Layers ► Save Layer Selection

► Identify Feature ► Load Layer Selection 

Add Labels/Images and Measure: Add graphics or take measurements on the 

map if desired.

► Draw ► Measure Area

► Measure Distance

Download Layers or Print Map: Download a PDF of the completed map and 

download the GIS layers if desired. 

► Download Data ► Print Map
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Advancing Transportation through 
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Training Courses

How to Log into ATLAS Search Tool

• Via Direct URL

• Via Connect Homepage

• Via Connect Preconstruction Home

• Via Connect Project Site  
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0.0 Log In Basics

0.1 There are four ways to log in to access 

the ATLAS Screening Tool:

1. Via Direct URL: This the easiest 

and quickest way to access the 

ATLAS Screening Tool.

2. Via Connect Home Page: This is 

useful if you already find yourself 

working within the Connect page 

and want to jump into the Screening 

Tool.

3. Via Connect Preconstruction Home: 

This is useful if you are already 

logged into the Connect 

Preconstruction site, but are not on 

a specific project page.

4. Via Project Site: When working 

within projects on the Connect 

project site, easily jump into the 

Screening Tool.

Accessing ATLAS Screening Tool

There are four ways to log into the Screening Tool.

Click on the hyperlinks in the list to the right to jump directly 

to one of these methods or continue to advance the module 

to view all four. 

Once you have accessed the tool, you will log in. Click on 

the links below to jump directly to that topic.

• Logging in after accessing the Screening Tool

• Troubleshooting issues
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1.0 Accessing ATLAS Via Direct URL

1.1 When accessing ATLAS via direct link, 

you’ll follow this URL: 

https://connect.ncdot.gov/resources/Env

ironmental/EAU/Project-

Atlas/Pages/default.aspx

1.2 From there, you’ll select the ATLAS 

Data Search Tool or ATLAS Data 

Screening Tool in the “ATLAS Tools” 

section.

Tip: Bookmark this URL for easier future access

https://connect.ncdot.gov/resources/Environmental/EAU/Project-Atlas/Pages/default.aspx
https://connect.ncdot.gov/resources/Environmental/EAU/Project-Atlas/Pages/default.aspx
https://connect.ncdot.gov/resources/Environmental/EAU/Project-Atlas/Pages/default.aspx
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2.0 Accessing ATLAS Via Connect Home Page

2.1 Begin by accessing the Connect Home 

Page URL: 

https://connect.ncdot.gov/Pages/default.

aspx

2.2 Then, click the Resources button in the 

header.

Tip: If, after hitting Resources, your browser 

prompts you to Sign In, you can hit Cancel and 

continue the steps to accessing your ATLAS 

account.

Generally, this pop up appears to non-NCDOT 

users.

https://connect.ncdot.gov/Pages/default.aspx
https://connect.ncdot.gov/Pages/default.aspx
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2.0 Accessing ATLAS Via Connect Home Page (continued)

2.3 Next, click Environmental in the grey 

bar at the top of the screen.

2.4 Then select Environmental Analysis

from the left side.

1

2
1

2
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2.0 Accessing ATLAS Via Connect Home Page (continued)

2.5 From there, select Project ATLAS. 

Tip: If you don’t see Project ATLAS on your 

screen, scroll down – it will appear alphabetically.
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2.0 Accessing ATLAS Via Connect Home Page (continued)

2.6 You’re now in the ATLAS homepage. 

Select ATLAS Data Search Tool or

ATLAS Data Screening Tool to 

continue your log in.
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3.0 Accessing ATLAS Via Preconstruction Home

3.1 To access ATLAS via the 

Preconstruction Home page, navigate 

to the Preconstruction homepage and 

select ATLAS Search Tool from the 

left-hand side menu.
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4.0 Accessing ATLAS Via Connect Project Site

4.1 To access ATLAS via the Connect 

Project Site, navigate to the 

Preconstruction homepage and search 

your project in the Find a Site search 

bar.
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4.0 Accessing ATLAS Via Connect Project Site (continued)

4.2 1. In the menu on the left side, under 

the ATLAS Tools section at the 

bottom of the list.

2. From the bottom tab on the right 

side, under the ATLAS Tools tab.

1

2

1

2
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5.0 Logging Into ATLAS 

5.1 You will need to log into ATLAS 

regardless of the method you used to 

access the ATLAS Screening Tool if you 

are an NCDOT or non-NCDOT user, or 

if you previously logged into Connect. 

When prompted with this log in, fill out 

your NCID Username and Password.

5.2 Click the NCID Login button.
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5.0 Logging Into ATLAS (continued)

5.3 In the next pop-up, choose Using your 

NCID account.
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5.0 Logging Into ATLAS (continued)

5.4 When prompted with the Disclaimer, 

click I Accept and you’re in!

ATLAS may automatically log out after a period of 

inactivity, or will stop operating correctly.
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6.0 Troubleshooting Issues

6.1 If you’re having issues with your NCID

log in, you can follow the Need Help? 

prompt.
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6.0 Troubleshooting Issues (continued)

6.2 If you’re having issues within your 

ATLAS account, you can follow the 

Help function found on the header or 

send an email to ATLAS@ncdot.gov.
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Advancing Transportation through 
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Overview of the Search Tool
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1.1 The header houses four functions: 

►ATLAS Screening Tool icon: 

Allows users to access the ATLAS 

Screening Tool; this will open in a 

new window

►About: Takes users to a 

comprehensive page describing 

ATLAS, its tools, and previous 

updates

►Additional Resources: Leads to a 

page of linked resources and their 

descriptors for additional 

information

►Help: A link to the email to use for 

any questions or problems you may 

have: ATLAS@ncdot.gov

1.0 Overview of Header

1

2

3

4

1 2 3 4

mailto:ATLAS@ncdot.gov


A Guide to the 

ATLAS Search Tool

22

Return to Introduction Slide

2.0 Search Tool Uses

2.1 The following slides provide detail on each of the 

following functions, which can be done in any order: 

Zoom Into Area of Interest: Find an area by 

downloading or creating a study area, or simply 

zooming into the map.

► Find Location ► Add a Study Area

Select Layers: Select the layers to be viewed or 

downloaded.

► Search for Layers ► Save Layer Selection

► Identify Feature ► Load Layer Selection

Add Labels/Images and Measure: Add graphics or 

take measurements on the map if desired.

► Draw ► Measure Area

► Measure Distance

Download Layers or Print Map: Download a PDF of 

the completed map and download the GIS layers if 

desired. 

► Download Data ► Print Map

The remaining slides 

in this presentation 

will walk you through 

each of the functions 

listed to the right. 
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Advancing Transportation through 

Linkages, Automation, and Screening (ATLAS)

Training Courses

Zoom Into Area of Interest
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0.1 There are four ways to zoom into your 

area of interest:  

► Zoom In

► Zoom Out

►Location Search

►Use Coordinates

More information about how to use the 

Coordinates is on the following Find 

Location slide.

►Add Study Area

More information about how to build or 

import a study area is on the following 

Add a Study Area slide.

0.0 Before We Begin

1

2

1

2

3

4

43
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2.1 Click the Find Location icon to find the 

coordinates of any point on the map. 

Click the      icon, then move anywhere 

on the map to see its location. The XY 

coordinates will be displayed on the top 

right corner of the map. 

To zoom to a specific location, click on 

the        button on the far right side of 

the menu, then click on the        button. 

Check the box next to “Go to location,” 

enter the coordinate pairing, and click 

“Enter” on your keyboard.

Click on the        button to convert your 

XY coordinates to a different unit.

1.0 Find Location

1

2

3

1

2

3
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2.0 Add a Study Area

2.1 When adding a study area, you can 

choose to Upload or Draw your area.

More details on both options are on the 

following slides.

Once you click the map icon, you’ll see 

an Information box that notes your 

study area is limited to 10 square miles. 

Clicking OK will close this window.

1

2

3

1

2

3
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2.0 Add a Study Area (continued)

2.2 To Upload a Study Area, you’ll be 

brought to a navigation window, which 

you can use to click through your 

computer’s files and select a map of the 

study area. This file must be a zipped 

shapefile.

Reminder: Your study area must be 10 

square miles or less.
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2.0 Add a Study Area (continued)

2.3 To Draw a Study Area, you can choose 

between a custom polygon, or a 

standard rectangle or circle. 

Once you choose a shape, draw your 

study area.

Reminder: Your study area must be 10 

square miles or less.
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Advancing Transportation through 

Linkages, Automation, and Screening (ATLAS)
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Select Layers
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0.1 There are four options in the layer 

selection function. 

More information about these options 

are on the following slides.

► Search for Layers

► Identify Feature

► Save Layer Selection

►Load Layer Selection

0.0 Before We Begin

1

2

3

4

1 2

43
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1.0 Search for Layers

1.1 Use this tool to add layers to your map. 

When you click on the      , a new menu 

will open. 

Data can be searched by category or 

key word. 

The layers are organized into two main 

categories: Human Environment and 

Natural Environment. 

More information about the search 

options are in the following slides. 

Click Back to Map at any time to see 

the selected layers on the map. You can 

switch back and forth between the map 

and layer selection. 

Layers without checkboxes are secured and 

cannot be added to the map. 

1

2

3

1

3

4

4

2
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1.0 Search for Layers (continued)

1.2 You’ll notice as you work through the 

ATLAS Search Tool that sometimes 

there is an asterisk (*) next to certain 

data layers.

All layers are available in the ATLAS 

Search Tool. This asterisk is an 

indicator that this specific layer is also  

available in the ATLAS Screening 

Tool.
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1.0 Search for Layers (continued)

1.3 The Layers Meeting Search Criteria 

indicator is there to show you how many 

layers are available for use that meet 

the search criteria you used.

When you expand the Human 

Environment and Natural 

Environment tabs, the sub-categories 

containing the layers meeting your 

search criteria will be listed. 
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1.0 Search for Layers (continued)

1.4 There are 3 types to search from:

►Category: Available layers are 

grouped by topic or theme

►Document: Available layers are 

grouped by the type of report or 

deliverable for which they are often 

utilized

► Organization: Available layers are 

grouped by the source of the data

These options are described in more 

detail on the following slides.

Click the + next to each category to 

expand the selection. 

Click in the box to the left of each layer 

name to select one or more of these 

data layers. Clicking again in the box 

will un-select that layer. 
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1.0 Search for Layers (continued)

1.5 Under the Category button, available 

layers are grouped by topic or theme. 
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1.0 Search for Layers (continued)

1.6 Under the Document button, available 

layers are grouped by the type of report 

or deliverable for which they are often 

utilized. 

These documents include natural resources 

reports, community impact assessments, 

comprehensive transportation plans, noise 

reports, and land use assessments, among 

others.

Note that some layers are used in multiple 

documents, and therefore can be found in multiple 

drop-downs.  
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1.0 Search for Layers (continued)

1.7 Under the Organization button, 

available layers are grouped by the 

source of the data. The ATLAS Search 

Tool provides access to data developed 

by dozens of different federal, state, and 

local agencies. This search option 

allows users to browse layers by owner. 

These organizations can include municipality, 

county, city, and national organizations, among 

others.
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1.0 Search for Layers (continued)

1.8 To search by Keyword, type a word into 

the keyword space relevant to the 

desired data layer. 

Keywords will pull up data sets that 

contain the search text in their name, 

description, or owning organization.

Remember: the Search By filter will 

impact how each layer is displayed, for 

example document will produce all 

documents with the keyword in it, 

whereas category and organization only 

produce one of each layer.

Try using different keywords (for example, “crash” 

vs. “safety”), or different versions of the same 
word (for example, “road” vs. “roads”). 
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2.0 Identify Feature

2.1 Use this tool to identify features on the 

map. Click on the      , then click on a 

feature in the map. A window will 

appear showing more information on 

the feature you clicked.

If more than one feature exists where 

you clicked, you may access 

information on these stacked features 

by clicking on the forward arrow at the 

top of the identify window. 

Relevant data and attachments 

associated with the feature are in the 

information window; use the scroll bar to 

see all data and links.  

Click on the      to dock the window on 

the right-hand side of the screen. Click

to close the information window.

Zoom into the map for a more precise location.

1

2

3

4

1
3

2
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3.1 Use the Save Layer tool to save a 

combination of layers that you selected 

in the Search for Layers step. Saving 

the layer selection makes it available for 

future use in other maps as a “Saved 

Map.” 

To save, add all the layers you want to 

the layer list, then hit the Save button. 

You can also choose whether you want 

to Save a new layer list or Update an 

old layer list.

To Save a new layer list, enter a Name

and description. 

To Update a previously-saved layer 

selection, select the layer list to 

overwrite and update the description.

This saved list of layers will be accessible through 

the Load Saved Map step described on the 

following slide. You may save multiple layer 

combinations during this step.

3.0 Save Layer Selection

1

2

1

2

2
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4.1 Use the Load Saved Map step to add a 

previously saved list of layers to your 

map. 

Click the       icon and select from either 

DOT ATLAS Maps (NCDOT-created 

templates) or Your Maps (Layer 

selections you’ve made and saved in 

the past). 

From there select which layers to load 

by clicking Load once to take you to the 

description window.

Then, click Load once more to add to 

them. You can also add or remove 

layers at this point, after loading the 

saved list.

All layers in that set will be added to your legend. 

This saved list is associated with your NCID and 

will be available on all Workbench maps for 

projects you can access.

4.0 Load Layer Selection

1

2

3

1

2

3
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Advancing Transportation through 

Linkages, Automation, and Screening (ATLAS)

Training Courses

Add Labels/Images and Measure
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0.1 There are three options in the 

labels/images and measuring function. 

More information about these options 

are on the following slides.

► Draw

When you click the Draw icon, a new 

tool bar will pop up with additional 

options. 

►Measure Distance

►Measure Area

0.0 Before We Begin

1

2

3

1 2

3
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1.0 Draw: Overview

1.1 Use the draw tool to add graphics to 

your map. When you click on the      , a 

new drawing toolbar will appear in the 

top right corner of the map.

Your drawn features will be added to the 

‘Map Drawings’ layer on your Table of 

Contents (TOC). 

Use the     icon on the TOC to turn 

drawn features on and off, move the 

layers above or below others, or change 

the opacity (transparency).

The shape drawn with the draw tool is temporary 

for the current session and does not have any 

data associated with it. You can also label your 

drawing with the       function. 

1

2

1

2
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1.0 Draw: Add a Label

1.2 When you click on the Speech Bubble 

icon, a Create Label box appears 

where you can enter the Label’s text, 

and select its color, angle, weight, and 

size. 

Once filled out, click on the Ok and 

Select Location button to click a 

location on the map to place the label. 

Your labels will be added to the Map 

Labels layer on your table of contents.

1

2

1

2
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1.0 Draw: Remove a Label or Image

1.3 To Remove a label or image that you 

have placed on the map, click on the 

Remove Label button, indicated by the      

icon, and select on the label or 

image in the map. The following menu 

extension will appear: 

You can click “Delete” on your keyboard 

or click on the       icon. 
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1.0 Draw: Transform and Reshape

1.4 Use the Select Feature tool to move or 

reshape any feature drawn on the map. 

Click on the icon, then click on the 

feature. You can: 

1. Shift it to the desired location

2. Reshape it by moving individual 

vertices

3. Rotate it by using the circle that 

appears above the shape

Remember, these shapes are not study areas and 

will not be used when generating reports or 

analyzing data. They will only display as images in 

the map.



A Guide to the 

ATLAS Search Tool

48

Return to Introduction Slide

1.0 Draw: Draw a Point

1.5 Use the Point tool to draw a dot 

anywhere on the map.

Once you place the point, you can move 

or delete it using the        icon. 
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1.0 Draw: Draw a Polyline

1.6 Use the Line tool to draw a polyline 

anywhere on your map. 

Double-click to finish drawing. 

Once you place the point, you can move 

or delete it using the        icon. 
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1.0 Draw: Draw a Polygon

1.7 Use the Polygon tool to draw a polygon 

anywhere on your map. 

The polygon must have at a minimum 

three points but there is not a maximum 

number of points. 

Double-click to finish drawing, the 

polygon will automatically complete to 

close the shape. Any double click after 

three points will complete the shape.

Once you place the point, you can move 

or delete it using the        icon. 



A Guide to the 

ATLAS Search Tool

51

Return to Introduction Slide

1.0 Draw: Draw a Rectangle

1.8 Use the Rectangle tool to draw a 

rectangle anywhere on your map. 

To begin the drawing, click on the map, 

hold the mouse button down, and drag 

in or out to control the size of the shape. 

The first point becomes a corner 

point. 

To end the drawing, release the mouse 

button. 

Once you place the point, you can move 

or delete it using the        icon. 
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1.0 Draw: Draw a Circle

1.9 Use the Circle tool to draw a circle 

anywhere on your map. 

To begin the drawing, click on the map, 

hold the mouse button down, and drag 

in or out to control the size of the shape.

The first point becomes the center 

point. 

To end the drawing, release the mouse 

button. 

Once you place the point, you can move 

or delete it using the        icon. 
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1.0 Draw: Undo a Map Action

1.10 Use the Undo tool to undo a map 

operation. This works to undo actions 

involving resizing of shapes.

To undo creation of a shape, use the 

Remove Label function. 
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1.0 Draw: Redo a Map Action

1.11 Use the Redo tool to redo a map 

operation. This works to redo an “undo” 

action involving resizing of shapes.
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2.1 Use this to measure distance 

between any two points on the map. 

After you click the      icon, click the blue 

New Measurement button in the top 

right corner of the map. 

Click on the map to start measuring. As 

you measure, the distance will be noted. 

To end your measurement, double click.

You can change the units using the 

dropdown menu. 

Start a new measurement at any point 

using the New Measurement button. 

Keep in mind that this clears your last 

measurement.

To clear the measurement toolbar, click 

again on the      icon.

2.0 Measure Distance 

1

2
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3.1 This tool works much like the previous 

one to measure distance, but 

measures an area. 

After you click the      icon, click the blue 

New Measurement button in the top 

right corner of the map. 

Click on the map to start measuring. As 

you measure, the distance will be noted. 

To end your measurement, double click.

You can change the units using the 

dropdown menu. 

You can start new measurement at any 

point using the New Measurement 

button. Keep in mind that this clears 

your last measurement.

The icon to measure area is the same as the icon 

used to draw a polygon in the draw tools.

3.0 Measure Area

1
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Advancing Transportation through 

Linkages, Automation, and Screening (ATLAS)

Training Courses

Download Layers or Print Map
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0.1 There are two options in the Download 

Layers or Print Map function. 

More information about these options 

are on the following slides.

► Download Data

► Print Map

0.0 Before We Begin

1

2

1
2
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1.1 The Download Data tool allows you to 

download your data, clipped to your 

study area, in one of the three available 

formats (SHP, GDB, or DGN). 

Select the      icon and choose a file 

format.

Labels and shapes drawn onto the map will not 

affect the area used to clip the data layers. The 

layers are clipped only by the study area that you 

have uploaded or drawn using the        icon.

1.0 Download Data

1

1
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1.0 Download Data (continued)

1.2 Once you select your file type and your 

map has downloaded, select OK.

Once downloaded, the file will appear at 

the bottom of your browser page, as 

well as in your computer’s download 

folder.

2
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2.0 Print Map

2.1 To Print a Map, select the Print icon.

On the right side of your screen, you’ll 

see a box where you can enter your 

Title, Page setup, and File format.

To finish, click Export. 

1

2

3

1 2

3
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2.2 Once exported, the file will appear 

under Exported files. 

Clicking “Export” does not automatically download 

to the user’s downloaded folder. To access the 

downloaded files, click the “Exported files” link and 

download individual files to your computer.

2.0 Print Map (continued)

1

1
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Module SE.00 Reference Table

# Step Slides

1 Log into ATLAS Search Tool 5-19

2 Zoom into Area of Interest 23-28

3 Select Layers 29-41

4 Add Labels/Images and Measure 42-56

5 Download Layers and Print Map 57-62

SE.00
A Guide to the 

ATLAS Search Tool

You have now completed this module.

For additional questions, email 
ATLAS@ncdot.gov
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